UNLV Graduate College’s Organization of the Thesis and Dissertation Compiled Manuals

This document includes all of the manuals found within Tab 5: Organization of the Thesis and Dissertation on the Thesis and Dissertation website.

Updated January 15, 2017
Purpose of this Document

This document includes guidelines, tips, and examples for each section of the thesis or dissertation that is found within Section 5: Organization of the Thesis and Dissertation. The purpose is to make it easy to print out all of the manuals in one go.

**Remember:** The sections are presented in the order of how the material **must be presented** in your document:

1. Cover page
2. Copyright page
3. Approval page
4. Abstract
5. Acknowledgements
6. Dedication (optional)
7. Preface (optional)
8. Table of Contents
9. List of Tables
10. List of Figures
11. Any other lists, including: List of Definitions, List of Algorithms, List of Equations
12. Main body of your text
13. Appendix or appendices
14. Bibliography/ References
15. Curriculum Vitae
Table of Contents

Section 1: Cover Page.................................................................................................................. 1
  1a: Format of the Cover Page .................................................................................................. 1
  1b: Cover Page Help (Correct Degree Titles)........................................................................ 4
  1c: Cover Page Help (Academic Units).................................................................................. 9

Sample Cover Page for Master’s Degree ................................................................................... 14
Sample Cover Page for Doctoral Dissertation .......................................................................... 15
Sample Cover Page for Single Author Doctoral Project ........................................................... 16
Sample Cover Page for Multiple Author Doctoral Project ....................................................... 17

Section 2: Copyright Information, Embargoing the Thesis/Dissertation Information, and the Copyright Manual ........................................................................................................ 18
  2a: Copyright Information ....................................................................................................... 18
  2b: Embargoing a Thesis or Dissertation ................................................................................. 18
  2c: General Format of the Copyright Page ............................................................................. 19

Sample APA Style Copyright Page ........................................................................................... 20
Sample MLA Style Copyright Page ............................................................................................ 21
Sample Chicago Style Copyright Page ...................................................................................... 22

Section 3: Approval Page ......................................................................................................... 23

Section 4: Abstract .................................................................................................................... 24

Section 5: Acknowledgements .................................................................................................. 25

Section 6: Dedication ................................................................................................................ 26

Section 7: Preface ...................................................................................................................... 27

Section 8: Table of Contents Manual ....................................................................................... 28
  8a: Formatting the Table of Contents .................................................................................... 28
  8b: Manually Creating a Table of Contents in Microsoft Word .............................................. 29
Section 1: Cover Page

1a: Format of the Cover Page

6 Main Sections of the Cover Page:

1. Title of Thesis or Dissertation
2. Your Legal Name
3. A list of any degrees equivalent to a Bachelor’s degree or higher that have already been conferred.
4. The correct degree name
5. The correct department name/ The correct college name/ The Graduate College
6. University of Nevada, Las Vegas/ Graduation Date (Last month/year of the semester you are graduating)

General Format:

- First page of the thesis or dissertation document.
- Not numbered.
- Each line of type is centered between the 1 inch margin on the left and the 1 inch margin on the right.
- No headers or footers in the margins.
- Do not divide words at the end of lines.
- Each section should be separated by at least one blank line.

Section 1: Format of the Thesis or Dissertation Title:

- The title is in all CAPITAL LETTERS, centered in an inverted triangle as shown in the examples (below).
- It is double-spaced.
- It is the same font and size as the rest of the document.

Section 2: Format of Your Name:

- Immediately follows the Thesis or Dissertation title.
- Consists of two lines:
  i. By
  ii. Legal Name
- Must use your full legal name as listed as your primary name in MyUNLV.
  - If you would like to change your name, please see the following link: [http://system.nevada.edu/Nshe/index.cfm/administration/academics-student-affairs/forms/personal-identification-data/](http://system.nevada.edu/Nshe/index.cfm/administration/academics-student-affairs/forms/personal-identification-data/)

Section 3: Format for the List of Degrees:
o Only degrees equivalent to a Bachelor’s degree or higher that have already been conferred are listed immediately under your name.
  o If you are receiving your first master’s degree (example below), then only the information for your bachelor’s degree is listed.
  o If you are receiving another master’s degree, then the master’s degree(s) you have already received will be listed below the bachelor’s degree.

o Information included: Degree, University, Year of Degree Conferment. These three pieces of information need to go on 3 separate lines.

o The bachelor degree(s) should always be listed first.

o The master degree(s) or professional degree(s) are listed after the bachelor degree(s).

**Section 4: Format for the Correct Degree Name:**

o This section contains two parts:
  i. A dissertation (thesis) submitted in partial fulfillment of the requirements for the
  ii. Correct degree name

o For the first part, dissertation or thesis is chosen depending on whether the degree being conferred is a doctoral or master’s degree, respectively.

o For the second part, the degree the student is obtaining should not include the word “degree”. Some examples of the correct degree titles include: Master of Arts -- Criminal Justice, and Doctor of Philosophy in Engineering.

o See Section 2: Cover Page Help: Correct Degree Names (starts on p. 4) for the complete list of correct degree names. This will allow you to correctly determine the respective degree title for your thesis or dissertation.

o If you already have multiple degrees, the degree order is bachelors, masters/professional, then doctoral. For example, if you already have an M.A., J.D., and M.D. then your section would be listed in order of Bachelor’s, Master’s, Juris Doctor, and Doctor of Medicine:

  Bachelor of Arts – Elementary Education
  Western Michigan University
  1992

  Master of Arts – Sociology
  University of Arizona
  1994

  Juris Doctor
  University of New Mexico
  1996

  Doctor of Medicine
  University of California, Los Angeles
  2002

o If you have multiple of one type of degree, such as a bachelor’s degree, they will appear chronologically listed through the filter of degree type. For example, if you are a doctoral
student with two bachelor degrees’ (1998 and 2002) and a master’s degree (2010), then your section would be listed in the order of BA (1998), BA (2002), and MA (2010):

Bachelor of Arts – Elementary Education  
Western Michigan University  
1998

Bachelor of Arts – Sociology  
University of Arizona  
2002

Master of Arts – Sociology  
University of New Mexico  
1996

○ If you have earned two of the same type of degree from the same institution in the same year, they would just be stacked in the same entry:

Bachelor of Arts – Elementary Education
Bachelor of Arts – Sociology  
Western Michigan University  
1992

Master of Arts – Sociology  
University of New Mexico  
1996

Section 5: Format for the correct department name, correct college name, and the Graduate College:

○ This section consists of three lines:
  i. Correct department name
  ii. Correct college name
  iii. The Graduate College

○ See the Section 3: Cover Page Help: Academic Units (starting below on pg. 8) for a list of how to write out this information for your respective academic unit. This will allow you to copy and paste the information onto your cover page to minimize errors (make sure to change the font style and size to match the rest of your document).

Section 6: Format for listing the University of Nevada Las Vegas and Graduation Date:

○ This section consists of two lines:
  i. University of Nevada, Las Vegas
  ii. Graduation Date

○ Make sure the comma separates ‘University of Nevada’ and ‘Las Vegas’

○ The graduation date should include the month & year of official graduation (only options: December, May or August).
  ○ If graduating in the Fall semester, the date should include December Year.
  ○ If graduating in the Spring semester, the date should include May Year.
  ○ If graduating in the Summer semester, the date should include August Year.
Division of Health Sciences

Doctor of Philosophy – Interdisciplinary Health Studies

School of Allied Health Sciences
Master of Science – Exercise Physiology
Master of Science – Health Physics
Master of Science – Kinesiology
Doctor of Philosophy – Health Physics
Doctor of Philosophy – Kinesiology
Doctor of Physical Therapy

School of Dental Medicine
Master of Science – Oral Biology

School of Nursing
Master of Science – Nursing
Doctor of Philosophy – Nursing
Doctor of Nursing Practice

School of Community Health Sciences
Master of Health Care Administration
Master of Public Health
Doctor of Philosophy – Public Health

William F. Harrah College of Hotel Administration

Master of Science – Hotel Administration

Executive Master of Hospitality Administration

Doctor of Philosophy – Hospitality Administration

Lee Business School

Accounting
Master of Science – Accounting

Economics
Master of Arts – Economics
College of Liberal Arts

Anthropology
Master of Arts – Anthropology
Doctor of Philosophy – Anthropology

English
Master of Arts – English
Master of Fine Arts – Creative Writing
Doctor of Philosophy – English

History
Master of Arts – History
Doctor of Philosophy – History

Political Sciences
Master of Arts – Political Science
Doctor of Philosophy – Political Science

Psychology
Doctor of Philosophy – Psychology

Sociology
Doctor of Philosophy – Sociology

World Languages and Cultures
Master of Arts – Hispanic Studies

Howard R. Hughes College of Engineering

Civil and Environmental Engineering and Construction
Master of Science – Construction Management
Master of Science in Engineering – Civil and Environmental Engineering
Master of Science in Transportation
Doctor of Philosophy – Civil and Environmental Engineering

Computer Science
Master of Science in Computer Science
Doctor of Philosophy – Computer Science

Electrical & Computer Engineering
Master of Science in Engineering – Electrical Engineering
Doctor of Philosophy – Electrical Engineering

Mechanical Engineering
Master of Science in Aerospace Engineering
Master of Science in Engineering – Mechanical Engineering
Master of Science – Biomedical Engineering
Master of Science – Materials and Nuclear Engineering
Doctor of Philosophy – Mechanical Engineering

College of Education

*Educational Psychology and Higher Education*
Master of Education – Higher Education
Master of Science – Educational Psychology
Doctor of Philosophy – Learning and Technology
Doctor of Philosophy – Educational Psychology
Doctor of Philosophy – Higher Education
Educational Specialist – Educational Psychology

*Education and Clinical Studies*
Master of Education – Early Childhood Education
Master of Education – Special Education
Master of Education – School Counseling
Master of Science – Clinical Mental Health Counseling
Doctor of Philosophy – Special Education

*Teaching and Learning*
Master of Science – Curriculum & Instruction
Doctor of Education – Curriculum & Instruction
Doctor of Philosophy – Curriculum & Instruction
Doctor of Philosophy – Teacher Education
Educational Specialist – Curriculum & Instruction

College of Fine Arts

*School of Architecture*
Master of Architecture

*Music*
Master of Music
Doctor of Musical Arts

*Theatre*
Master of Arts – Theatre
Master of Fine Arts – Theatre

College of Sciences
Master of Arts in Science

Mathematical Sciences
Master of Science – Mathematical Sciences
Doctor of Philosophy – Mathematical Sciences

Chemistry
Master of Science – Biochemistry
Doctor of Philosophy – Chemistry
Doctor of Philosophy – Radiochemistry

Physics & Astronomy
Master of Science – Astronomy
Master of Science – Physics
Doctor of Philosophy – Astronomy
Doctor of Philosophy – Physics

Geoscience
Master of Science – Geoscience
Doctor of Philosophy – Geoscience

Water Resources Management
Master of Science – Water Resource Management

School of Life Sciences
Master of Science – Biological Sciences
Doctor of Philosophy – Biological Sciences

Greenspun College of Urban Affairs

Communication Studies
Master of Arts – Communication Studies

Criminal Justice
Master of Arts – Criminal Justice
Doctor of Philosophy – Criminal Justice

Hank Greenspun School of Journalism & Media Studies
Master of Science – Marriage and Family Therapy

School of Environmental and Public Affairs
Master of Arts – Urban Leadership
Master of Science – Environmental Science
Doctor of Philosophy – Environmental Science
Doctor of Philosophy – Public Affairs
Doctor of Philosophy – Workforce Development and Organization Leadership

Social Work
Master of Social Work
1c: Cover Page Help (Academic Units)

School of Allied Health Sciences

Department of Health Physics and Diagnostic Sciences
School of Allied Health Sciences
Division of Health Sciences
The Graduate College

Department of Kinesiology and Nutrition Sciences
School of Allied Health Sciences
Division of Health Sciences
The Graduate College

Department of Physical Therapy
School of Allied Health Sciences
Division of Health Sciences
The Graduate College

Lee Business School

Department of Accounting
Lee Business School
The Graduate College

Department of Economics
Lee Business School
The Graduate College

Department of Finance
Lee Business School
The Graduate College

Department of Management, Entrepreneurship, and Technology
Lee Business School
The Graduate College

Department of Marketing and International Business
Lee Business School
The Graduate College
School of Community Health Sciences

Department of Environmental and Occupational Health
School of Community Health Sciences
Division of Health Sciences
The Graduate College

Department of Health Care Administration and Policy
School of Community Health Sciences
Division of Health Sciences
The Graduate College

School of Dental Medicine

School of Dental Medicine
Division of Health Sciences
The Graduate College

College of Education

Department of Educational and Clinical Studies
College of Education
The Graduate College

Department of Educational Psychology and Higher Education
College of Education
The Graduate College

Department of Teaching and Learning
College of Education
The Graduate College

Howard R. Hughes College of Engineering

Department of Civil and Environmental Engineering and Construction
Howard R. Hughes College of Engineering
The Graduate College

Department of Computer Science
Howard R. Hughes College of Engineering
The Graduate College

Department of Electrical and Computer Engineering
Howard R. Hughes College of Engineering
The Graduate College
Department of Mechanical Engineering
Howard R. Hughes College of Engineering
The Graduate College

College of Fine Arts

School of Architecture
College of Fine Arts
The Graduate College

Department of Art
College of Fine Arts
The Graduate College

Department of Film
College of Fine Arts
The Graduate College

School of Music
College of Fine Arts
The Graduate College

Department of Theater
College of Fine Arts
The Graduate College

William F. Harrah College of Hotel Administration
Resort, Gaming, and Golf Management
William F. Harrah College of Hotel Administration
The Graduate College

Hospitality Management
William F. Harrah College of Hotel Administration
The Graduate College

Food & Beverage and Event Management
William F. Harrah College of Hotel Administration
The Graduate College

College of Liberal Arts

Department of Anthropology
College of Liberal Arts
The Graduate College
Department of English
College of Liberal Arts
The Graduate College

Department of History
College of Liberal Arts
The Graduate College

Department of Political Science
College of Liberal Arts
The Graduate College

Department of Psychology
College of Liberal Arts
The Graduate College

Department of Sociology
College of Liberal Arts
The Graduate College

Department of World Languages and Cultures
College of Liberal Arts
The Graduate College

School of Nursing

School of Nursing
Division of Health Sciences
The Graduate College

College of Sciences

Department of Chemistry and Biochemistry
College of Sciences
The Graduate College

Department of Geoscience
College of Sciences
The Graduate College

School of Life Sciences
College of Sciences
The Graduate College

Department of Mathematical Sciences
College of Sciences
The Graduate College
Department of Physics and Astronomy
College of Sciences
The Graduate College
Water Resources Management Program
College of Sciences
The Graduate College

Greenspun College of Urban Affairs

Department of Communication Studies
Greenspun College of Urban Affairs
The Graduate College

Department of Criminal Justice
Greenspun College of Urban Affairs
The Graduate College

School of Public Policy and Leadership
Greenspun College of Urban Affairs
The Graduate College

Hank Greenspun School of Journalism and Media Studies
Greenspun College of Urban Affairs
The Graduate College

Marriage and Family Therapy Program
Greenspun College of Urban Affairs
The Graduate College

School of Social Work
Greenspun College of Urban Affairs
The Graduate College
ANALYZING THE SOCIAL EFFECTS OF A BETTER MOUSE TRAP: WHY DID MICKEY HAVE TO DIE?

By

Jerry D. Mouse

Bachelor of Arts – Elementary Education
Western Michigan University
1992

A thesis submitted in partial fulfillment of the requirements for the

Master of Arts – Sociology

Department of Sociology
College of Liberal Arts
The Graduate College

University of Nevada, Las Vegas
May 2015

Remember:
- No page numbers
- Each line of type is centered between the 1 inch margin on the left and the 1 inch margin on the right

Title is in all CAPS and centered in an inverted triangle

Full legal name as listed as your primary name in MyUNLV—see Section 2, p. 1 for more information

Only bachelor’s degree listed since the first master’s degree is being granted

See Section 2 in this manual for lists of correct degree titles

See Section 3 in this manual for lists of the academic units

REMEMBER
The comma ☺

Fall Graduation: December Year
Spring Graduation: May Year
Summer Graduation: August Year
Analyzing the Social Effects of a Better Mouse Trap: Why Did Mickey Have to Die?

By

Jerry D. Mouse

Bachelor of Arts – Elementary Education
Western Michigan University
1992

Master of Arts – Sociology
University of New Mexico
1993

A dissertation submitted in partial fulfillment of the requirements for the

Doctor of Philosophy – Sociology

Department of Sociology
College of Liberal Arts
The Graduate College

University of Nevada, Las Vegas
May 2015

Remember:
- No page numbers
- Each line of type is centered between the 1 inch margin on the left and the 1 inch margin on the right

Fall Graduation:
December Year

Spring Graduation:
May Year

Summer Graduation:
August Year

See Section 2 in this manual for lists of correct degree titles

See Section 3 in this manual for lists of the academic units

Full legal name as listed as your primary name in MyUNLV—see Section 2, p. 1 for more information

Remember
The comma 😊

Both the bachelor’s degree and master’s degree are listed since a doctoral degree is being granted

Remember
The comma 😊

REMEmber
The comma 😊

The comma 😊
PRACTICAL TREATMENTS FOR MOUSETRAP INJURIES:

DID MICKEY HAVE TO DIE?

By

Jerry D. Mouse

Bachelor of Arts – Elementary Education
Western Michigan University
1992

Master of Arts – Sociology
University of New Mexico
1993

A doctoral project submitted in partial fulfillment
of the requirements for the

Doctor of Nursing Practice

School of Nursing
Division of Health Sciences
The Graduate College

University of Nevada, Las Vegas
May 2015
PRACTICAL TREATMENTS FOR MOUSETRAP INJURIES:
DID MICKEY HAVE TO DIE?

By

Jerry D. Mouse
Min E. Mouse
Howard D. Duck
R. Raccoon

A doctoral project submitted in partial fulfillment of the requirements for the

Doctor of Physical Therapy

Department of Physical Therapy
School of Allied Health Sciences
Division of Health Sciences
The Graduate College

University of Nevada, Las Vegas
May 2015
Section 2: Copyright Information, Embargoing the Thesis/ Dissertation Information, and the Copyright Page Manual

2a: Copyright Information

What is copyright?

According to the United States Copyright Office, “Copyright is a form of protection grounded in the U.S. Constitution and granted by law for original works of authorship fixed in a tangible medium of expression. Copyright covers both published and unpublished works.”

General Copyright Information:

- The thesis or dissertation author automatically owns copyright to the document since it represents the author’s original documented work.
- Students have the opportunity to register a copyright on their thesis or dissertation with the U.S. Copyright Office through ProQuest. This is strictly optional, and there is a fee associated with the service. This fee is paid directly on the ProQuest site at the time of electronic submission.
- Students may also file a registration of copyright yourself (instead of using ProQuest) by sending a properly completed application form, a nonrefundable filing fee, and a nonreturnable copy of your thesis or dissertation to the United States Copyright Office.
- Several reasons for why individuals decide to register their work:
  - Individuals want the public record to show that they own the work’s copyright
  - Individuals want a certificate of registration
  - In successful litigation, works that are registered with the U.S. Copyright Office may be eligible for attorney’s fees and statutory damage.
- More Information on Copyright is available at the U.S. Copyright Office’s website: [http://lcweb.loc.gov/copyright](http://lcweb.loc.gov/copyright).
- Answers to frequently asked copyright questions can be found at [http://www.copyright.gov/help/faq/](http://www.copyright.gov/help/faq/).

2b: Embargoing a Thesis or Dissertation

- Some students may have a compelling reason to embargo their thesis or dissertation for a period of time to protect intellectual property rights or due to other publication restrictions. The UNLV Embargo Policy and Embargo Request Form are available here for your reference.
- Common reasons for embargos include but are not limited to publishing conflicts, patent applications, the potential to publish in the next 2 years, and funding contracts. Embargos

---

are available for 6 months, 1 year, 2 years, or 3 years at a time and must be renewed. For faster processing, embargo forms should be included with culminating experience and defense approval forms. For any additional questions, please contact Megan Wilson at megan.wilson@unlv.edu.

- Embargos since the author owns the copyright to the document can only be filed by the document’s author.

2c: General Format of the Copyright Page:

- If applicable, the copyright page is inserted after the title page in the document. Remember, this page is optional unless you register with the United States Copyright Office. Then you must have the copyright page.
- This page is not numbered. There are also no headers or footers in the margins.
- The most common copyright page consists of two lines, centered in the page and double-spaced:
  - First line: Copyright by Name (First then Last), YEAR
  - Second line: All Rights Reserved
- If submitting in December, date for January of the following year.
Copyright [Year] [Name of Copyright Owner]

All Rights Reserved
Copyright [Year] [Name of Copyright Owner]
All Rights Reserved
Section 3: Approval Page

General Information:

- A pdf of the appropriate approval page is downloaded from the Graduate College Thesis and Dissertation website, under the Approval Page section.

- There are three options for theses, dissertations, and musical doctoral documents:
  1. The standard approval form with signatures for a four-member committee
  2. An approval form with signatures for a five-member committee
  3. An approval form with signatures for a four-member committee with two co-chairs

- It represents the first numbered page in your document. It is always numbered with a small Roman numeral ii. The approval page you download from the Graduate College website is automatically numbered.

- Approval page should be printed in color and have original signatures from committee. If you do not have access to a color printer, you can have this page printed at the Campus Copy Center or any copy shop such as Kinkos, Office Depot, Office Max, Staples, etc.

- Make sure you have your approval page available for signing immediately following your oral defense.

- All signatures must be in blue or black ink

Filling out the Electronic Approval Page:

- Do not alter the downloaded approval page in any way. Contact Megan Wilson at 895-2747 prior to your defense if none of the options represents the structure of your examination committee.

- For the Date: type in the month/day/year of your defense. So if you defended on March 1st, your date would be March 1, 2015.

- DO NOT USE ALL CAPITAL LETTERS. Capitalize the First Letter of Your Name and Major Words as Shown in This Sentence. In addition, all inserted information is formatted to begin flush left.

- Degree Name: Use the template drop-down degree name list to locate and insert the exact name of the degree you are earning.

Submission:

- Approval page should be submitted to the Graduate College before the first submission deadline for the student’s defended and Advisory Committee approved document.

- Students are only required to turn in their hard copy approval page. After your document’s format is approved, the Graduate College will insert an electronic copy of your approval page into your final document for you to upload to ProQuest. This means that you do not need to put the approval page into your thesis or dissertation. You can leave a place holder, but this is optional.
Section 4: Abstract

- Must be numbered with a lower case Roman numeral iii. The page number (iii) should be bottom center on the page.
- Must be double spaced.
- All other formatting must be per the requirements of disciplines style guide or style guide that the thesis or dissertation committee members agreed upon.
Section 5: Acknowledgements

- This page is optional.
- It must follow the number order from the Abstract. Thus, if the abstract ended on Roman numeral v, then the Acknowledgments must start on Roman numeral vi.
- If you chose to include a Dedication, it will be placed after your Acknowledgements.
- Like other sections of your document, it must be formatted the same as the rest of your text with 1” margins, double spaced text, page numbers, etc.
Section 6: Dedication

- This page is optional.
- It must continue the number order from the Abstract.
- If you chose to have an Acknowledgements section, it must be on a separate page from your Acknowledges and it would be placed after your Acknowledgements before your Table of Contents.
- Like other sections of your document, it must be formatted the same as the rest of your text with 1” margins, double spaced text, page numbers, etc.
- A title is not required for your Dedication page.
- Your Dedication does not have to be listed in your Table of Contents.
Section 7: Preface

- This page is optional.
- It must continue the number order from the Abstract.
- Like other sections of your document, it must be formatted the same as the rest of your text with 1” margins, double spaced text, page numbers, etc.
- All other content and formatting rules will be determined by your discipline’s or department’s style guide.
Section 8: Table of Contents Manual

8a: Formatting the Table of Contents

- A Table of Contents (TOC) must appear in your thesis or dissertation document.
- The items that should be listed on the TOC include all pages from the abstract through the Curriculum Vitae. Thus, the TOC includes:
  1. Abstract (starts on page iii)
  2. Acknowledgements (optional)
  3. Dedication (optional)
  4. Preface (optional)
  5. Table of Contents (optional to put it on the TOC of your thesis/dissertation)
  6. List of Tables (if applicable)
  7. List of Figures (if applicable)
  8. Any other lists, including: List of Definitions, List of Algorithms, List of Equations (if applicable)
  9. Main body of your text (e.g., chapter titles, headings, and subheadings)
 10. Appendix or appendices (optional)
 11. Bibliography
 12. Curriculum Vitae

- As the last document in your text, the Curriculum Vitae is the last item on your TOC.
- The page numbers listed in the Table of Contents must match the page numbers of items as they appear in the text.
- The titles listed in the Table of Contents must match the titles as they appear in the text.
- In general, your document needs to be broken into Chapters/Sections. Chapters must appear on the Table of Contents. The title must match exactly between the Table of Contents and the text. The page number also needs to match exactly between the two.
- For example, if the chapter title, “Chapter 1 Introduction: An Unexpected Beginning,” is used on page 5 of the text, the Table of Contents should list:
  - Chapter 1 Introduction: An Unexpected Beginning ......................5
- Chapter sections and subsections should appear consistently in the Table of Contents. If a level of subsection is included in the Table of Contents, then all subsections at that level must be listed in the Table of Contents. Subsections and subheadings are not required to be listed in your text or Table of Contents.

---

2 Information for this manual has been modified from University of Central Florida College of Graduate Studies. (2012). Step 3: Table of Contents. Retrieved from http://www.students.graduate.ucf.edu/ETD_formatting/.
Creative dissertations (novellas, novels and poetry) that do not have a chapter structure should have at least 1 major section listed in addition to their front materials and Curriculum Vitae. Collections of short stories should list the stories contained in the collection as sections in the Table of Contents.

8b: Manually Creating a Table of Contents in Microsoft Word

There are two ways that you can generate a TOC in Microsoft Word: typing it manually or creating it automatically. This section discusses the former.

Typing the TOC manually:

This method involves: 1.) typing the TOC entries (chapter titles, headings, and subheadings) and 2.) using either tabs to get the dotted lines or dot leaders between each entry and its respective page number.

On the TOC page:

1. Type the first entry

2. Press Tab and then type its respective page number (remember make sure the page number matches exactly between the document and what is listed on the TOC)

3. Then select the Tab stop character. In order to show the Tab stop character, click the Home tab. Then click Show/Hide in the paragraph group.
4. Click the arrow found at the bottom left hand corner of the paragraph group.

5. This launches the Paragraph Dialog Box. Click the Tabs button.
6. Type 6.4” under the Tab stop position. This means that your number will end at the 1” margin (Remember all margins, including the left margin, for the thesis or dissertation must be 1”).

7. Under Alignment, click Right.

8. Under Leader, chose option 1. The use of leaders in the text is prohibited.

9. Click Set and then OK.

10. Press Enter. Type your next entry, press Tab, and then type the entry’s respective page number.

11. Repeat until your Table of Contents is finished.
Note: Primary, secondary, tertiary, etc., levels of headings should be formatted per the rules laid out in your style guide. Your style guide will breakdown how each level of heading will appear in your text and in your Table of Contents.

Section 8c: Create a Table of Contents in Microsoft Word Automatically

In order to create a TOC in Microsoft Word automatically, you need to have already applied heading styles to the major heading as well as all subheadings in your thesis or dissertation document. For help applying heading styles to these items please see below Section 12: Main Body of the Text: Headings and Subheadings Manual (p. 80). Assigning a style to each heading and subheading enables Word to track the location of these items. This then allows Word to create a list of them or a TOC.

Generating a TOC Automatically:

1. Since you will be generating the TOC from heading styles, it is important to determine that all major headings and subheadings have the heading style that you intended. All of your major headings (e.g., chapter headings, Abstract, Table of Contents, etc.) should all use the Heading 1 style, all of your primary or first-level subheadings should all use the Heading 2 style, and so on.

2. Go to your currently blank Table of Contents page in your document. If you did not save a page for the Table of Contents, then please add it now. Make sure your major heading (Table of Contents) follows the other major headings style.

3. Go to the References Tab.

![Table of Contents Page in Microsoft Word](image)
4. Click on the Table of Contents. It is located on the farthest left hand side of the References ribbon.

5. Choose “Insert Table of Contents.” The Table of Contents box appears. Click on the tab labeled “Table of Contents.” A similar image should appear.

6. Choose the Options button.
7. The menu “Table of Contents Options” appears. Here is where you can choose which headings and subheadings to include on the Table of Contents.

8. At the very minimum, Heading 1 must be on the TOC. Thus, the corresponding TOC level must be 1. The rest of the Heading styles are optional to place on the TOC, but their TOC level should correspond with the subheading level. For example, primary or first level subheadings are Heading style 2 and their TOC level is 2, secondary or second level subheadings are Heading style 3 and their TOC level is 3, and so on. If you do not want a Heading style to appear on the Table of Contents then remove the TOC level number.

9. Once you are finished, click OK. Click OK again on the Table of Contents box. This should generate your TOC on the Table of Contents page.

Note: If you see mistakes in your headings or subheadings (e.g., spacing problems, misspellings, etc.) on the Table of Contents page, do not correct the mistakes on the Table of Contents page.
itself. Rather, go to the heading or subheading in your document and make the necessary corrections. You will need to update the Table of Contents to reflect the changes.

Updating the Table of Contents:

1. Go back to the References tab.

2. In the Table of Contents section (farthest left-hand corner), you will see “Update Table.”

3. Select this option and your Table of Contents will be updated.
# Table of Contents

Abstract ........................................................................................................................................ iii

Acknowledgements ....................................................................................................................... iv

Dedication ....................................................................................................................................... vi

List of Tables .................................................................................................................................. x

List of Figures .................................................................................................................................. xi

Chapter 1: Introduction .................................................................................................................. 1

Chapter 2: Historical Background ................................................................................................ 14

Chapter 3: Methodology ................................................................................................................ 44

Chapter 4: Analysis ........................................................................................................................ 102

Chapter 5: Conclusion ................................................................................................................... 139

References ...................................................................................................................................... 169

Curriculum Vitae ............................................................................................................................. 182
# Table of Contents

**Abstract** .................................................................................................................................................. iii

**Acknowledgements** .................................................................................................................................. v

**List of Tables** .............................................................................................................................................. vii

**List of Figures** ............................................................................................................................................ ix

**List of Equations** ........................................................................................................................................ x

**Chapter 1: Introduction** ............................................................................................................................ 1

- Overview .................................................................................................................................................. 2
- Bees ........................................................................................................................................................... 3
  - Why Bees Are Better than Wasps ............................................................................................................ 3
  - Context of Little Black Rain Cloud Incident (1907) .............................................................................. 4
- American Foulbrood (AFB) disease ......................................................................................................... 4
- Current AFB disease management .......................................................................................................... 7

**Chapter 2: Bees Make Honey** .................................................................................................................. 19

- Abstract ................................................................................................................................................... 19
- Introduction ............................................................................................................................................... 20
- Methods and Materials .......................................................................................................................... 22
- Results ..................................................................................................................................................... 28
- Discussion ................................................................................................................................................ 31

**Chapter 3: Low Carb Diets Prohibit Honey Consumption** .................................................................... 48

- Abstract ................................................................................................................................................... 48
- Literature Review ...................................................................................................................................... 49
- Bees in Books .......................................................................................................................................... 50
- Bees in Cinema ......................................................................................................................................... 52
- Bees on a Plane ......................................................................................................................................... 55

**Chapter 4: Low Carb Diets are Killing Off Honey Bees** ........................................................................ 57
Sample Table of Contents: With Subheadings

Table of Contents

Abstract .......................................................................................................................... iii
Acknowledgements .......................................................................................................... v
List of Tables ..................................................................................................................... vii
List of Figures .................................................................................................................... ix

Chapter 1: Introduction ................................................................................................. 1
  1.1: Overview .................................................................................................................. 2
  1.2: Bees ....................................................................................................................... 3
      1.2.1 Why Bees Are Better than Wasps ................................................................. 3
  1.2.2 Context of Little Black Rain Cloud Incident (1907) .......................................... 4
  1.3: American Foulbrood (AFB) disease ..................................................................... 4
  1.4: Current AFB disease management ..................................................................... 7

Chapter 2: Bees Make Honey ...................................................................................... 19
  2.1: Abstract ............................................................................................................... 19
  2.2: Introduction ......................................................................................................... 20
  2.3: Methods and Materials ..................................................................................... 22
  2.4: Results ............................................................................................................... 28
  2.5: Discussion .......................................................................................................... 31

Chapter 3: Low Carb Diets Prohibit Honey Consumption ...................................... 48
  3.1: Abstract ............................................................................................................. 48
  3.2: Literature Review ............................................................................................. 49
      3.2.1: Bees in Books ........................................................................................... 50
      3.2.2: Bees in Cinema ....................................................................................... 52
      3.2.3: Bees on a Plane ....................................................................................... 55

Chapter 4: Low Carb Diets are Killing Off Honey Bees ........................................... 57
  4.1: Abstract ............................................................................................................. 57
4.2: Introduction ........................................................................................................................................57
4.3: Methods and Materials .....................................................................................................................59
4.4: Results ...............................................................................................................................................64
4.5: Discussion ..........................................................................................................................................68
Appendix: Random Bee Information ........................................................................................................122
References .............................................................................................................................................132
Curriculum Vita .......................................................................................................................................147
TABLE OF CONTENTS

ABSTRACT .................................................................................................................................................. iii

PREFACE ...................................................................................................................................................... iv

ACKNOWLEDGEMENTS ......................................................................................................................... v

PREFACE ...................................................................................................................................................... vi

1: THE MILLER’S WIFE ......................................................................................................................... 1

2: SALTED EARTH .................................................................................................................................... 80

CURRICULUM VITAE ............................................................................................................................... 117
Section 9: Manual for Formatting the Tables and the List of Tables in the Thesis or Dissertation

9a: Formatting Tables within the Thesis or Dissertation

General Formatting Guidelines:

- Be sure that all inserted tables are labeled with a title and number
  - Example: Table 1. Total Number of Graduate Students from 1986 to 1997

- The numbering for each table must be consecutive, per the requirements of your chosen style guide.
  - Numbering can be from the beginning of the document or from the start of each chapter. For example, Table 1. Total Number of Graduate Students from 1986 to 1997 or Table 1. Total Number of Graduate Students from 1986 to 1997

- Your casing choices must match between all of the table labels and should follow the requirements of your chosen style guide.
  - For example, if you titles are in ALL CAPS in your text, they will need to in ALL CAPS in your list of tables and through out your other table titles. The rule applies to titles that are Title Cased, lower cased, or Just capitalize the first word of the title.

- If a table is landscape oriented, the table’s label and page number must be landscape oriented to match.

- **Tables must be clearly delineated from the text.** This can be done by line breaks (minimum 2 line breaks or 2 double-spaced lines), borders, or a delineation that is approved by your style guide. The title and description of tables are considered part of the table and must be clearly delineated from the text as well.

- Tables embedded into your document must fit on a single page. You can use smaller font size on tables, but it cannot be below 8 point size. If the embedded item does not fit within your text on a single page, it must be moved to an appendix. You can either give each table its own appendix or you can create a single appendix containing multiple tables.

- Unlike the rest of your document, the descriptions and titles of tables embedded in your document can be single-spaced.

- You must use the same font style as the rest of your document. As noted above, the font size can be smaller than the rest of the font size in the document.

---

Inserting a caption for a table in Microsoft Word:

Using this function in Microsoft Word enables you to ensure that there is consistency among table titles throughout your document. These captions will also then enable you to automatically create a List of Tables. **Remember:** All tables need to be formatted identically with each other.

1. Find your first table in your document.

2. Position your mouse cursor at the beginning of the table’s title/ description. Go to the References tab.

3. On this tab, select Insert Caption. This is located in the center of the References tab under the Captions section.

4. A menu will pop up and look similar to the image below.

5. Make sure the word “Table” is displayed in the Label section. If it does not, click on the down arrow in the Label section and select it from the list.

6. When the caption figure says “Table 1,” click OK.

7. The label “Table 1” should appear in front of your caption. You will notice that Word has changed the label and description of your table to its default settings.
8. You can change the caption formatting style by going to the Home tab. There you will see the Styles section in the ribbon. In the lower right-hand corner of the Styles section, you will see an arrow. Click on the arrow to bring up the Styles menu.

9. Click anywhere on the caption (label or description) and this display the Captions option in the Styles menu.

10. Click on the down arrow located to the right of “Caption.”

11. Choose Modify.
12. This is where you can modify the font style, font size, the position of the label and description (e.g., centered, left-aligned), and the line spacing (e.g., single-spaced).

13. Once you have fixed the style of the caption, click OK. The caption for your table should reflect these changes. From here, all captions for your tables should look the same.

14. To insert a caption for the rest of the tables in your document, follow the above steps.

15. The only change is that instead of making sure the label is “Table 1” (Step 7 above), the number must be changed to accurately reflect the order of the respective table.
Eius solum similique pri te, errem decore perpetua an his. This idea is clearly illustrated in Tables 1.1 and 1.2.

Table 1. UNLV’s Student Population Preference for Chocolate or Vanilla Cupcakes (By Class-Standing).

<table>
<thead>
<tr>
<th>Student Status</th>
<th>Prefer Chocolate Cupcakes</th>
<th>Prefer Vanilla Cupcakes</th>
<th>Prefer Other Type of Cupcake</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undergraduate Students</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>565</td>
<td>400</td>
<td>52</td>
</tr>
<tr>
<td>Sophomore</td>
<td>787</td>
<td>878</td>
<td>115</td>
</tr>
<tr>
<td>Junior</td>
<td>412</td>
<td>432</td>
<td>25</td>
</tr>
<tr>
<td>Senior</td>
<td>125</td>
<td>200</td>
<td>300</td>
</tr>
<tr>
<td><strong>Graduate Students</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graduate</td>
<td>325</td>
<td>250</td>
<td>412</td>
</tr>
</tbody>
</table>

Table 2. UNLV’s Student Population Preference for Cats or Dogs (By Class-Standing).

<table>
<thead>
<tr>
<th>Student Status</th>
<th>Prefer Cats</th>
<th>Prefer Dogs</th>
<th>Prefer Other Animal Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undergraduate Students</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>200</td>
<td>125</td>
<td>50</td>
</tr>
<tr>
<td>Sophomore</td>
<td>325</td>
<td>330</td>
<td>41</td>
</tr>
<tr>
<td>Junior</td>
<td>87</td>
<td>98</td>
<td>125</td>
</tr>
<tr>
<td>Senior</td>
<td>225</td>
<td>275</td>
<td>300</td>
</tr>
<tr>
<td><strong>Graduate Students</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graduate Students</td>
<td>574</td>
<td>300</td>
<td>25</td>
</tr>
</tbody>
</table>

Section 2: Fun with Latin 2.0?

This next section explores text text text text text text text text text text text text text text text text.
Sample 2: Properly Formatted Table

Section 3: Fun with Latin 3.0?


Eius solum similique pri te, errem decore perpetua an his. In sale nulla nusquam eam. An sed euripidis interesset, homero disputando quo ad, est reque viderer cu. Petentium accusamus has ex, eu sale reque lobortis per, his tollit corpora appareat ei.


This might seem like a lot of space, but if you look on the next page (p. 7) the table takes up almost a full page. This much space is allowed if your table (or figure) would not fit in the space remaining on the respective page.

Remember: The table cannot be split onto two pages. It must fit on one page or it will need to go into an appendix.

Also, note that the text on Table 3 is smaller than the other two tables. This
Table 3. College of Liberal Arts Students’ Preferences for Chocolate Chip Cookies or Oatmeal Raisin Cookies.

<table>
<thead>
<tr>
<th>Department/Student Class-Standing</th>
<th>Prefer Chocolate Chip Cookies</th>
<th>Prefer Oatmeal Raisin Cookies</th>
<th>Prefer Other Cookie Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Department of Anthropology</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>42</td>
<td>53</td>
<td>99</td>
</tr>
<tr>
<td>Sophomore</td>
<td>112</td>
<td>205</td>
<td>20</td>
</tr>
<tr>
<td>Junior</td>
<td>51</td>
<td>54</td>
<td>102</td>
</tr>
<tr>
<td>Senior</td>
<td>99</td>
<td>89</td>
<td>199</td>
</tr>
<tr>
<td>Graduate</td>
<td>15</td>
<td>205</td>
<td>2</td>
</tr>
<tr>
<td><strong>Department of English</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>34</td>
<td>52</td>
<td>125</td>
</tr>
<tr>
<td>Sophomore</td>
<td>69</td>
<td>78</td>
<td>1</td>
</tr>
<tr>
<td>Junior</td>
<td>152</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>Senior</td>
<td>159</td>
<td>201</td>
<td>63</td>
</tr>
<tr>
<td>Graduate</td>
<td>32</td>
<td>23</td>
<td>1</td>
</tr>
<tr>
<td><strong>Department of History</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>23</td>
<td>65</td>
<td>123</td>
</tr>
<tr>
<td>Sophomore</td>
<td>152</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>Junior</td>
<td>51</td>
<td>54</td>
<td>102</td>
</tr>
<tr>
<td>Senior</td>
<td>99</td>
<td>89</td>
<td>199</td>
</tr>
<tr>
<td>Graduate</td>
<td>15</td>
<td>205</td>
<td>2</td>
</tr>
<tr>
<td><strong>Department of Philosophy</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>65</td>
<td>56</td>
<td>66</td>
</tr>
<tr>
<td>Sophomore</td>
<td>99</td>
<td>102</td>
<td>32</td>
</tr>
<tr>
<td>Junior</td>
<td>212</td>
<td>321</td>
<td>2</td>
</tr>
<tr>
<td>Senior</td>
<td>56</td>
<td>87</td>
<td>9</td>
</tr>
<tr>
<td>Graduate</td>
<td>12</td>
<td>22</td>
<td>33</td>
</tr>
<tr>
<td><strong>Department of Political Science</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>5</td>
<td>97</td>
<td>186</td>
</tr>
<tr>
<td>Sophomore</td>
<td>4</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Junior</td>
<td>12</td>
<td>15</td>
<td>22</td>
</tr>
<tr>
<td>Senior</td>
<td>98</td>
<td>98</td>
<td>5</td>
</tr>
<tr>
<td>Graduate</td>
<td>5</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td><strong>Department of Psychology</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>45</td>
<td>36</td>
<td>2</td>
</tr>
<tr>
<td>Sophomore</td>
<td>89</td>
<td>98</td>
<td>9</td>
</tr>
<tr>
<td>Junior</td>
<td>23</td>
<td>3</td>
<td>99</td>
</tr>
<tr>
<td>Senior</td>
<td>32</td>
<td>22</td>
<td>12</td>
</tr>
<tr>
<td>Graduate</td>
<td>2</td>
<td>32</td>
<td>10</td>
</tr>
<tr>
<td><strong>Department of Sociology</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>23</td>
<td>32</td>
<td>333</td>
</tr>
<tr>
<td>Sophomore</td>
<td>26</td>
<td>26</td>
<td>3</td>
</tr>
<tr>
<td>Junior</td>
<td>105</td>
<td>115</td>
<td>1</td>
</tr>
<tr>
<td>Senior</td>
<td>2</td>
<td>5</td>
<td>7</td>
</tr>
<tr>
<td>Graduate</td>
<td>3</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td><strong>Department of World Languages and Cultures</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>56</td>
<td>65</td>
<td>79</td>
</tr>
<tr>
<td>Sophomore</td>
<td>112</td>
<td>115</td>
<td>3</td>
</tr>
<tr>
<td>Junior</td>
<td>115</td>
<td>112</td>
<td>59</td>
</tr>
<tr>
<td>Senior</td>
<td>23</td>
<td>65</td>
<td>2</td>
</tr>
<tr>
<td>Graduate</td>
<td>2</td>
<td>2</td>
<td>9</td>
</tr>
</tbody>
</table>
9b: Format Requirements for the List of Tables

- The List of Tables is placed immediately before the List of Figures (if you also have a List of Figures).

- It must be labeled as “List of Tables”

- The List of Tables is mandatory only if there are 5 or more tables found in the document. However, you can choose to have a List of Tables if there are 4 or less tables in the document.

- Regardless of whether you are required to have a List of Tables or if you chose to have a List of Tables, all tables included in your text and appendices must appear in your List of Tables.

- Furthermore, if you chose to have a List of Tables, you are bound by all list formatting rules and you must include all tables on the list (found in both the document and the appendices).

- The page numbers listed in the List of Tables must match the page number as they appear in the text.

- The label and number for each table listed in the List of Tables must match exactly as they appear in the text.

- The label is considered to be the first sentence after your listed table number. This sentence must match verbatim between the List of Tables and the text.

- Your casing choice must also match between your table label in the text and in the List of Tables.
  
  - For example: if your List of Tables contains Table 4b: Oatmeal Consumed from 1820-1851; the corresponding table label in the text should be Table 4b: Oatmeal Consumed from 1820-1851.

- The format used for your List of Tables must match the formatting style of your Table of Contents, List of Figures, and any other lists included in your front material.
9c: How to Manually Create a List of Tables

This method is almost identical to how you would manually create a Table of Contents (see Table of Contents Manual - p. 24 and Manual for Formatting the Figures and the List of Figures in the Thesis or Dissertation - p. 62) in Microsoft Word.

On the List of Tables page:

1. Make sure you have the Heading “List of Tables” on the page. Be sure that it follows the format for all other major headings throughout the document (See Section 12: Main Body of the Text: Headings and Subheadings Manual for help with formatting major headings using the Style guides in Microsoft Word - p. 75.)

2. Type the first entry. Remember:
   - Table Number and Label
   - Make sure the font style, font size, and casing match between the List of Tables and the text.

3. Press Tab and then type its respective page number (Remember: make sure the page number matches exactly between the document and what is listed on the List of Tables)

4. Then select the Tab stop character. In order to show the Tab stop character, click the Home tab. Then click Show/Hide in the paragraph group.
5. Click the arrow found at the bottom left hand corner of the paragraph group.

6. This launches the Paragraph Dialog Box. Click the Tabs button.
7. Type 6.4” under the Tab stop position. This means that your number will end at the 1” margin (Remember all margins, including the right margin, for the thesis or dissertation must be 1”).

8. Under Alignment, click Right.

9. Under Leader, choose item 1. The Graduate College style guide does not allow for leaders.

10. Click Set and then OK.

11. Press Enter. Type your next entry, press Tab, and then type the entry’s respective page number.

Repeat until your List of Tables is finished.
9d: How to Create a List of Tables Automatically in Microsoft Word

Adding captions via the Captions section (under References tab), enables you to automatically create a List of Tables in Microsoft Word. Make sure that your captions have been properly inserted and modified. If they are not, then it will cause issues when you try and create your List of Tables.

1. Go to your blank List of Tables page.
2. Hit enter so that have a blank line underneath the List of Tables heading.
3. Click the References tab. Select the Insert Table of Figures, found in the Captions section.

4. The Table of Figures menu will appear. Yours should look similar to the one below.
5. Make sure that the Caption label says “Table.”

6. In order to modify the font size, font style, and make sure the List is double-spaced, click on the modify button. This will bring up another the Style menu. Click modify again and this will bring up the Modify Style menu.

7. Once you have made the necessary changes, click OK (all three menus).

8. The List of Tables will be generated.

**Remember:** Similar to the Table of Contents, you cannot fix any misspellings or spacing problems on the List of Tables itself. Instead, you will need to go to the caption itself and make the corrections. You will then need to update the List of Tables to reflect the changes.

**Updating the List of Tables:**

There are two options to update the List of Tables.

**First Option:** The first is that under the Modify Style menu (Step 6 above), you can click “Automatically update.” This will ensure that any changes made to the tables (caption spelling or their placement) will be automatically updated on the List of Tables.
Second option:

1. Navigate your mouse to the Table of Contents itself. Right-click within the Table of Contents. It will turn grey and two menus will appear.

   ![List of Tables](image)

   - Select "Update Field." Another menu will appear.
   - Choose “Update entire table” and click OK. This will update your List of Tables to reflect any changes you may have made to the tables’ captions or placement in the document.
List of Tables

Table 1. UNLV’s Student Population Preference for Chocolate or Vanilla Cupcakes (By Class-Standing) .......................................................... 52

Table 2. UNLV’s Student Population Preference for Cats or Dogs (By Class-Standing) ................. 52

General Notes:

- The List of Tables is labeled as “List of Tables.”

- If your description is several sentences long, only the first sentence after your listed table number needs to appear on the List of Tables. This sentence must match verbatim between the List of Tables and the text.

- The List of Tables heading must match the format of all other major headings in the document.
Chapter 1

Eius solum similique pri te, errem decore perpetua an his. In sale nulla nusquam eam. This idea is clearly illustrated in Tables 1.1 and 1.2.

Table 4. UNLV’s Student Population Preference for Chocolate or Vanilla Cupcakes (By Class-Standing).

<table>
<thead>
<tr>
<th>Student Status</th>
<th>Prefer Chocolate Cupcakes</th>
<th>Prefer Vanilla Cupcakes</th>
<th>Prefer Other Type of Cupcake</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undergraduate Students</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>565</td>
<td>400</td>
<td>52</td>
</tr>
<tr>
<td>Sophomore</td>
<td>787</td>
<td>878</td>
<td>115</td>
</tr>
<tr>
<td>Junior</td>
<td>412</td>
<td>432</td>
<td>25</td>
</tr>
<tr>
<td>Senior</td>
<td>125</td>
<td>200</td>
<td>300</td>
</tr>
<tr>
<td>Graduate Students</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graduate</td>
<td>325</td>
<td>250</td>
<td>412</td>
</tr>
</tbody>
</table>

Table 5. UNLV’s Student Population Preference for Cats or Dogs (By Class-Standing).

<table>
<thead>
<tr>
<th>Student Status</th>
<th>Prefer Cats</th>
<th>Prefer Dogs</th>
<th>Prefer Other Animal Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undergraduate Students</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freshman</td>
<td>200</td>
<td>125</td>
<td>50</td>
</tr>
<tr>
<td>Sophomore</td>
<td>325</td>
<td>330</td>
<td>41</td>
</tr>
<tr>
<td>Junior</td>
<td>87</td>
<td>98</td>
<td>125</td>
</tr>
<tr>
<td>Senior</td>
<td>225</td>
<td>275</td>
<td>300</td>
</tr>
<tr>
<td>Graduate Students</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graduate Students</td>
<td>574</td>
<td>300</td>
<td>25</td>
</tr>
</tbody>
</table>

Section 2: More stuff in Latin?

This next section explores Eius solum similique pri te, errem decore perpetua an his. In sale nulla nusquam eam. An sed euripidis interesset, homero disputando quo ad, est reque viderer cu.
Section 10: Manual for Formatting the Figures and the List of Figures in the Thesis or Dissertation

10a: Formatting Figures within the Thesis or Dissertation

General Formatting Guidelines:

- Be sure that all inserted figures are labeled with a title and number
  - Example: Figure 1. Reaction shot.

- The numbering for each figure must be consecutive, per the requirements of your chosen style guide.
  - Numbering can be from the beginning of the document or from the start of each chapter. For example, Figure 1: Reaction shot or Figure 1.1 Reaction shot.

- Your casing choices must match between all of the figure labels and should follow the requirements of your chosen style guide.
  - For example, if you titles are in ALL CAPS in your text, they will need to be in ALL CAPS in your list of figures and throughout your other figure titles. The rule applies to titles that are Title Cased, lower cased, or Just capitalize the first word of the title.

- If a figure is landscape oriented, the figure’s label and page number must be landscape oriented to match. The page number should appear bottom center on the page.

- Figures must be clearly delineated from the text. This can be done by line breaks (minimum 2 line breaks or 2 double-spaced lines), borders, or a delineation that is approved by your style guide. The title and description of figures are considered part of the figure and must be clearly delineated from the text as well.

- Figures embedded into your document must fit on a single page. You can use smaller font size on figure captions, but it cannot be below 8 point. If the embedded item does not fit within your text on a single page, it must be moved to an appendix. You can either give each figure its own appendix or you can create a single appendix containing multiple figures.

- Unlike the rest of your document, the descriptions and titles of figures embedded in your document can be single-spaced.

- You must use the same font style as the rest of your document. As noted above, the font size can be smaller than the rest of the font size in the document.

---

Inserting a caption for a figure in Microsoft Word:

Using this function in Microsoft Word enables you to ensure that there is consistency among figure titles throughout your document. These captions will also then enable you to automatically create a List of Figures. Remember: All figures need to be formatted identically with each other.

1. Find your first figure in your document.

2. Position your mouse cursor at the beginning of the figure’s title/description. Go to the References tab.

3. On this tab, select Insert Caption. This is located in the center of the References tab under the Captions section.

4. A menu will pop up and look similar to the image below.

5. Make sure the word “Figure” is displayed in the Label section. If it does not, click on the down arrow in the Label section and select it from the list.

6. When the caption figure says “Figure 1,” click OK.
7. The label “Figure 1” should appear in front of your caption. You will notice that Word has changed the label and description of your figure to its default settings.

8. You can change the caption formatting style by going to the Home tab. There you will see the Styles section in the ribbon. In the lower right-hand corner of the Styles section, you will see an arrow. Click on the arrow to bring up the Styles menu.

9. Click anywhere on the caption (label or description) and this will display the Captions option in the Styles menu.

10. Click on the down arrow located to the right of “Caption.”

11. Choose Modify.
12. This is where you can modify the font style, font size, the position of the label and description (e.g., centered, left-aligned), and the line spacing (e.g., single-spaced).

13. Once you have fixed the style of the caption, click OK. The caption for your figure should reflect these changes. From here, all captions for your figures should look the same.

14. To insert a caption for the rest of the figures in your document, follow the above steps.

15. The only change is that instead of making sure the label is “Figure 1” (Step 7 above), the number must be changed to accurately reflect the order of the respective table.
Mary had a little lamb, but the cat ate it. This caused a great deal of anguish not only for Mary but for the cat, not to mention the lamb. This idea is clearly illustrated in Figure 1.1.

![Figure 1. Reaction Shot.](image)

Section 2: Does the writer need a hobby?

This next section will look at the evidence presented above as just cause as to why the writer more than likely needs an actually hobby. Other evidence includes but is not limited to the amount of time spent on this, the number of hours sent at work, and the number Monty Python sketches memorized.
Sample 2: Properly Formatted Figure

Section 3: Fun with Latin

Eius solum similique pri te, errem decore perpetua an his. In sale nulla nusquam eam. An sed euripidis interesset, homero disputando quo ad, est reque viderer cu. This is illustrated in Figure 2.

Figure 2. Grumpy Cat.


Note: There is less space separating Figure 2 from the text than Figure 1. However, this is permitted since Figure 2 has a border around it. If you put a border around your figure (or table) than you do not need the double line break since the figure is clearly delineated from the text.
Sample 3: Properly Formatted Figure

Section 3: Cool camels love Lorem ipsum

Ne salutandi consetetur theophrastus mei, illum choro cu nec. Dico dolor intellegam quo et. Id qui stet facilisi, aperiri ceteros probatus ei est. Vix harum homero noluisse te, alia tota ne usu. Ut iusto laboramus consequuntur duo, ea sale nihil assentior quo. This is illustrated in Figure 3.

This might seem like a lot of space, but if you look on the next page (p. 8) the figure takes up almost a full page. This much space is allowed if your figure(or table) would not fit in the space remaining on the respective page.

Remember: The figure cannot be split onto two pages. It must fit on one page or it will need to go into an appendix.
Figure 3. Two Cool Camels.


10b: Format Requirements for the List of Figures

- The List of Figures is placed immediately after the List of Tables (or if you do not have a List of Tables directly after your Table of Contents).

- It must be labeled as “List of Figures”

- The List of Figures is mandatory only if there are 5 or more figures found in the document. However, you can choose to have a List of Figures if there are 4 or less figures in the document.

- Regardless of whether you are required to have a List of Figures or if you chose to have a List of Figures, all figures included in your text and appendices must appear in your List of Figures.

- Furthermore, if you chose to have a List of Figures, you are bound by all list formatting rules and you must include all figures on the list (found in both the document and the appendices).

- The page numbers listed in the List of Figures must match the page numbers listed for each figure as they appear in the text.

- The label and number for each figure listed in the List of Figures must match exactly as they appear in the text.

- The label is considered to be the first sentence after your listed figure number. This sentence must match verbatim between the List of Figures and the text.

  - For example: if your List of Figures contains Figure 2: Grumpy Cat; the corresponding table label in the text should be Figure 2: Grumpy Cat. It should not be Figure 1: Grumpy or Figure 1: Cat or Figure 1: Grumpy Cat Chilling on Friday Afternoon.

- Your casing choice must also match between your figure label in the text and in the List of Figures.

  - For example: if your List of Figures contains Figure 4b: Two Cool Camels; the corresponding table label in the text should be Figure 4b: Two Cool Camels. It should not be Figure 4b: Two cool Camels or Figure 4b: Two cool camels, etc.

- The format used for your List of Figures must match the formatting style of your Table of Contents, List of Tables, and any other lists included in your front material.
10c: How to Manually Create a List of Figures

This method is almost identical to how you would manually create a Table of Contents or List of Tables (see Table of Contents Manual and Manual for Formatting the Tables and the List of Tables in the Thesis or Dissertation in this document) in Microsoft Word.

On the List of Figures page:

1. Make sure you have the Heading “List of Figures” on the page. Be sure that it follows the format for all other major headings throughout the document (See Section 12: Main Body of the Text: Headings and Subheadings Manual for help with formatting major headings using the Style guides in Microsoft Word).

2. Type the first entry. Remember:
   xiii. Figure Number and Label
   xiv. Make sure the font style, font size, and casing match between the List of Figures and the text.

3. Press Tab and then type its respective page number (Remember: make sure the page number matches exactly between the document and what is listed on the List of Figures)

4. Then select the Tab stop character. In order to show the Tab stop character, click the Home tab. Then click Show/Hide in the paragraph group.
5. Click the arrow found at the bottom left hand corner of the paragraph group.

6. This launches the Paragraph Dialog Box. Click the Tabs button.
7. Type 6.4” under the Tab stop position. This means that your number will end at the 1” margin (Remember all margins, including the right margin, for the thesis or dissertation must be 1”).

8. Under Alignment, click Right.

9. Under Leader, select option 1. The Graduate College does not allow leaders.

10. Click Set and then OK.

11. Press Enter. Type your next entry, press Tab, and then type the entry’s respective page number.

**Repeat until your List of Figures is finished.**
10d: How to create a List of Figures Automatically in Microsoft Word?

Adding captions via the Captions section (under References tab), enables you to automatically create a List of Figures in Microsoft Word. Make sure that your captions have been properly inserted and modified. If they are not, then it will cause issues when you try and create your List of Figures.

1. Go to your blank List of Figures page.

2. Hit enter so that have a blank line underneath the List of Tables heading.

3. Click the References tab. Select the Insert Table of Figures, found in the Captions section.

4. The Table of Figures menu will appear. Yours should look similar to the one below.
5. Make sure that the Caption label says “Figure.” If it does not, click the down arrow and choose “Figure.”
6. In order to modify the font size, font style, and make sure the List is double-spaced, click on the modify button. This will bring up another the Style menu. Click modify again and this will bring up the Modify Style menu.
7. Once you have made the necessary changes, click OK (all three menus).
8. The List of Figures will be generated.

**Remember:** Similar to the Table of Contents and List of Tables, you cannot fix any misspellings or spacing problems on the List of Figures itself. Instead, you will need to go to the caption itself and make the corrections. You will then need to update the List of Figures to reflect the changes.

**Updating the List of Figures:**

There are two options to update the List of Figures.

**First Option:** The first is that under the Modify Style menu (Step 6 above), you can click “Automatically update.” This will ensure that any changes made to the figures (caption spelling or their placement) will be automatically updated on the List of Figures.
**Second Option:**

1. Navigate your mouse to the Table of Contents itself. Right-click within the Table of Contents. It will turn grey and two menus will appear.

   - Select "Update Field." Another menu will appear.

   - Choose "Update entire table" and click OK. This will update your List of Tables to reflect any changes you may have made to the tables’ captions or placement in the document.
List of Figures

Figure 1. Reaction Shot ........................................................................................................ 74

Figure 2. Grumpy Cat ........................................................................................................ 75
Mary had a little lamb, but the cat ate it. This caused a great deal of anguish not only for Mary but for the cat, not to mention the lamb. This idea is clearly illustrated in Figure 1.1.

Section 2: Does the writer need a hobby?

This next section will look at the evidence presented above as just cause as to why the writer more than likely needs an actually hobby. Other evidence includes but is not limited to the amount of time spent on this, the number of hours sent at work, and the number Monty Python sketches memorized.
Section 3: Text text text text?

Text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text text.
Section 11: Manual for Formatting Other Inserted Items and Their Respective Lists

11a: Formatting Other Inserted Items within a Thesis or Dissertation

General Formatting Guidelines:

- If your style guide requires you label other inserted items, such as images, equations, algorithms, graphs, diagrams, etc., these items must also be labeled with a title and number.
  - Example: Equation 1: Solving for X.

- The numbering for each type of inserted item must be consecutive, per the requirements of your chosen style guide.
  - Example: If you have three equations and three graphs, they must be consecutively numbered per each item type. The equations would be numbered: Equation 1, Equation 2, and Equation 3. The graphs would be numbered: Graph 1, Graph 2, and Graph 3. Like your tables and figures, these can be generalized for the entire document or delineated by chapter/section.

- Your casing choices must match between all of the inserted item labels and should follow the requirements of your chosen style guide.

- If an inserted item is landscape oriented, the inserted item’s label and page number must be landscape oriented to match.

- **Inserted items must be clearly delineated from the text.** This can be done by line breaks (minimum 2 line breaks or 2 double-spaced lines), borders, or a delineation that is approved by your style guide. The title and description of inserted items are considered part of the figure and must be clearly delineated from the text as well.

- Inserted items embedded into your document must fit on a single page. You can use smaller font size on their captions, but it cannot be below 8 point size. If the embedded item does not fit within your text on a single page, it must be moved to an appendix. You can either give each inserted item its own appendix or you can create a single appendix containing multiple inserted items.

- You must use the same font style as the rest of your document. As noted above, the font size can be smaller than the rest of the font size in the document.

Inserting a caption for an equation in Microsoft Word:

The process for inserting a caption for an equation in Microsoft Word is the same for inserting a caption for both figures and tables in Microsoft Word. The only difference is that instead of choosing either figure or table as the label in the Captions menu, you must chose equation. Since the process is the same, it will not be repeated here. Go to either the Manual for Formatting the
Tables and the List of Tables in the Thesis or Dissertation or the Manual for Formatting the Figures and List of Figures in the Thesis or Dissertation in this document.

Using this function in Microsoft Word enables you to ensure that there is consistency among equation titles throughout your document. These captions will also then enable you to automatically create a List of Equations.

**Remember:** All inserted items need to be formatted identically with each other, regardless of whether you use the insert caption function.
11b: Format Requirements for Other Lists of Embedded Items

- If there are five or more of any other embedded item (e.g., equations, algorithms, etc.) you can choose to reference them in a list in the front of your document.

- You are not required to include lists for these items but if you chose to include them, the label and the number of each item for each item must be listed along with the corresponding page number it appears on.

- The placement of each list should be in your front material after your Table Contents, List of Tables and List of Figures. The order of your embedded item lists should be per your style guide.

- The list for any embedded item should be titled “List of…” Examples include:
  - Algorithms would be “List of Algorithms”
  - Equations would be “List of Equations”

- If you chose to have a list of a particular embedded item, all of that type of embedded item included in your text and appendices must appear in your List.

- If you chose to have a List, you are bound by all list formatting rules.

- The page numbers listed in the List must match the page number of the item in the text.

- The label and number for each embedded item listed in the List must match the exact label used in the text.

- The label is considered to be the first sentence after your listed embedded item number. This sentence must match verbatim between the List and the text.

- Your casing choice must also match between your embedded item label in the text and in the List.
  - For example: if your List of Equations contains Equation 1: Solving for X; the corresponding embedded item label in the text should be Equation 1: Solving for X.

- The format used for your List must match the formatting style of your Table of Contents, List of Tables, and any other lists included in your front material.
11c: Creating a List of an Embedded Item Type

Manually Creating a List of an Embedded Item Type:

This method is almost identical to how you would manually create a Table of Contents or List of Tables or List of Figures (see Table of Contents Manual, Manual for Formatting the Tables and the List of Tables in the Thesis or Dissertation, or Manual for Formatting the Figures and the List of Figures in the Thesis or Dissertation in this document) in Microsoft Word. As a result, it will not be repeated here. Rather, we direct you to one of those three manuals and the respective sections.

Creating a List of Equations Automatically in Microsoft Word:

Only an automatic list can be generated for a List of Equations. For any other type of embedded item (excluding tables and figures), you will have to manually create a List. Since the method for creating a List of Equations automatically in Microsoft Word is almost identical to that for a List of Tables or List of Figures, it will not be repeated here. Rather, you are encouraged to go to either the Manual for Formatting the Tables and the List of Tables in the Thesis or Dissertation or Manual for Formatting the Figures and the List of Figures in the Thesis or Dissertation in this document.

The only difference is that in the Tables of Figures menu, the caption label should be Equations (not Tables or Figures).

Remember: Similar to the Table of Contents, List of Tables, and List of Figures you cannot fix any misspellings or spacing problems on the List of Equations itself. Instead, you will need to go to the caption itself and make the corrections. You will then need to update the List of Equations to reflect the changes.
Section 12: Body of the Text: Headings and Subheadings Manual

12a: Formatting Requirements for Headings and Chapters/Sections

Formatting Requirements for Headings:

- Heading sizes and styles must be consistent throughout the document. This means that all major headings (e.g., Table of Contents, chapter headings, References, etc.) must have the same style. Similarly each level of subheading (e.g., primary or first level subheadings, secondary or second level subheadings, etc.) must also have the same style.

- Headings (such as chapter titles or section titles) can be larger font size than the standard text, if in accordance with the student’s approved style guide and advisory committee. This style decision must be applied consistently throughout the text.

- All major headings must appear on the Table of Contents.

- You can chose whether or not to include all subheading levels on the Table of Contents; however, they must be consistently included on the Table of Contents. For example, if you chose to put primary subheadings on the Table of Contents then all primary subheadings must appear for all chapters/sections of your document and so on.

Formatting Requirements for Chapters and Sections:

- Each chapter/section must start on a new page, separate from the final paragraph of the preceding chapter.

- Page numbers remain continuous even when starting a new chapter/section.

- All chapters and sections must be listed on your Table of Contents.

- If chapters are used in your document, introductions and conclusions must be their own chapters or included in another chapter.

---

12b: Formatting Major Headings

General Information on Heading Styles in Microsoft Word:

Similar to Word automatically applying the Normal style to the body text of a document, Word also automatically creates Heading styles. These can be found in the Styles menu and include labels such as “Heading 1,” “Heading 2,” “Heading 3,” etc. Word automatically creates another heading style for you each time you apply a Heading style to a heading. This means that when you first apply Heading 1, Word automatically generates Heading 2 style for you.

Steps to Modify the Major Heading Styles:

Similar to modifying the Normal style and applying this to the main text in your document, you can also modify the Heading 1 style and apply this style to all major headings.

1. On the Home tab, find the Styles section. In this section, locate the style called “Heading 1.”

   ![Styles section in Word](image1)

2. Do not click on the “Heading 1.” Click the arrow located at the bottom right of the Styles box, which brings up the Styles box drop menu.

   ![Styles box drop menu](image2)
3. Move your mouse to “Heading 1.” The Paragraph symbol will change to an arrow. Click on the arrow. Another box will pop up. Click on Modify. The Modify Style box will pop up.

![Modify Style box](image)

**Note:** Depending on your version of Microsoft Word, Step 2 may not work. Instead, you can right click on the style you wish to change and select Modify. This will bring up the Modify Style box.

4. As discussed above, the Modify Style box includes all of the same information found on your toolbar. When we discussed modifying the Normal Style using this box, we noted you could change the default settings for your font size and font type, spacing, and more for the body text of your document. This time, in contrast, the Modify Style box **only** allows you to change items that you have designated as Heading 1.

Here is where you can change the font size and type, centering, bolding, spacing, color, etc.
5. Remember to also change the spacing after the heading.
   a. The default setting may have too much extra space. Select the format button located on the lower left hand corner in the Modify Style box for Heading 1.
   b. Select Paragraph from the drop menu that appears.
   c. The Paragraph window appears.
   d. In the Spacing section, set **Before** to 0 and **After** to the font size of the heading (e.g., 12 pt or 11 pt).
      For all other headings, **Before** and **After** should be the font size (e.g., both sections would have 12 pt).
   e. Line spacing should be set at double.
   f. Click OK out of all windows.
6. The Heading 1 style can now be applied to all major headings in the document. In order to make these modifications:
   a. Place the cursor at the beginning of the heading (you can also highlight it) then click on Heading 1 in the Styles box.
   b. Your heading should take on the characteristics that you created in the Modify Styles box.
   c. Make sure Heading 1 is applied to all major headings in your document.

Note: If you make any changes to the major headings style, it is important that these changes are not made using the functions on the main Home tab toolbar. Rather, follow these instructions and make any changes through the Modify Style box. Any changes that are made using the main Home tab toolbar can result in the creation of extra styles, resulting in your major headings not being consistent with one another.
12c: Formatting Subheadings

Steps to Modify the Subheading Styles:

Each level of subheading will be formatted with a different Heading style in the Styles section. You will have already used Heading 1 for the major headings. Thus, your primary (first-level subheadings) will use Heading 2, secondary (second-level) subheadings will use Heading 3, and so forth. Your style guide will dictate your subheading styles. If your department or discipline does not have a dedicated style guide, it will be reach by consensus between you and your advisory committee.

To modify your first subheading level (primary or first level subheading):

1. Click the arrow located at the bottom right of the Styles box. This will bring up the Styles box drop menu.

2. Move your mouse to “Heading 2.” The Paragraph symbol will change to an arrow. Click on the arrow. Another box will pop up. Click on Modify. The Modify Style box will pop up.
3. You will make changes to Heading 2 here the same way you modified Heading 1.
4. Once you have made all of the necessary changes, click OK out of all windows.
5. The Heading 2 style can now be applied to all major headings in the document. Follow the instructions for Heading 1 in order to make these modifications.

6. Make sure Heading 2 is applied to all primary (first-level) headings in your document.

7. Repeat the process to create each additional subheading level using Heading 3, Heading 4, and so on.

**Remember:** If you make any changes to a subheading level style, it is important that these changes are not made using the functions on the main Home tab toolbar. Rather, follow these instructions and make any changes through the Modify Style box.
12d: Clearing Mistakes Related to Style Formatting

You might accidently attribute a style to a particular section in your document. For example, a heading style might accidentally be applied to the body text which should be in the Normal style. If this happens, you can clear the formatting in order to remove the style you incorrectly applied.

1. Highlight the portion of your document that needs to be cleared. At the top of the Styles box, there should be a “Clear All” option.

2. Click this option.

3. The proper style needed can now be applied.

Remember: Do not try manually changing the section using the main Word toolbar. This will result in the creation of additional styles, which could make the formats for your major heading, subheadings, and paragraph style inconsistent.
Section 12: Main Body of the Text: Manual for Formatting Requirements for Font Size, Style, and Type and Spacing: Changing the Default Paragraph Styles

12a: Format Requirements for Font Size, Style, and Type and Spacing

Font size, style, and type:

- The font must be a standard style that is clear and readable. Script, cursive, and pictorial fonts are prohibited.
- All document text with the exception of items embedded in figures must be black.
- Font size should be 11 or 12 point.
- Italicized fonts are only accepted where allowed or required by your chosen style guide (Chicago, APA, ASA, MLA, etc.)
- Font size and font type must be consistent throughout the text.
- Chapter titles and sections can be a larger font size than the standard text, if in accordance with the student’s approved style guide and advisory committee. This style decision must be applied consistently throughout the text.
- The font size of tables and figures can be smaller than the standard text if in accordance with the student’s style guide and advisory committee. This style decision must be applied consistently throughout the text. Font cannot be at less than 8 point to allow for readability.

Spacing:

- The document must be double spaced.
  - The only exceptions are: captions; foot-notes; long quotations; bibliographic references; table titles and descriptions; figure titles and descriptions; inserted materials such as tables, images, diagrams, graphs, etc.; and the author’s curriculum vitae.
- Extended direct quotations must be handled according to the rules of your chosen style guide and the direction of your advisory committee.
- Paragraphs should be indented the same number of spaces throughout the document, and spacing between paragraphs should be consistent.
- Spacing around titles, headings, and subheadings should be consistent and match the student’s chosen style guide.

---

12b: Paragraph Style: The Default Style and How to Change It

The Default Style or The Normal Style:

The default setting for a new, blank Microsoft Word document (2007 or newer) is called the **Normal Style**. This means that when you open a new document, a default font style (Calibri), line spacing (1.15 spaces with an additional 10 points after each line), and font size (11 points) are already in place. The Normal style is highlighted in yellow in the Styles pane located at the top of your document in the Home tab.

These settings are automatically applied to the entire document unless you manually change them.

In order to apply a different paragraph style, individuals generally go to the Font and Paragraph tool bars in the Home tab (illustrated below). This allows people to change their font styles and line spacing, amongst other visual attributes.

However, there is another approach that is more advisable for electronic thesis and dissertation formatting. Instead of going to the Font and Paragraph tool bars, it is better to change the default template rather than just making changes to the body text only. Changing the Normal Style will ensure that the font style and size and paragraph spacing are consistent throughout your document. This prevents Word from reverting back to the default style at certain times, which may result in inconsistencies that you mostly want to avoid.

First, you want to make sure that the Normal Style is applied to the body text of your thesis/dissertation. If you have already manually changed the font style and size and paragraph spacing
using the Font and Paragraph tool bars, there is no reason to delete your work! You will want to make sure that the Normal Style matches whatever font style and size and paragraph spacing you have put in place. Remember the Graduate College has a few policies on this that must be followed:

- The document must be **double spaced**.
  - **Remember the exceptions are:** captions, footnotes, long quotations, bibliographic references, table titles and descriptions, figure titles and descriptions, inserted materials such as tables, images, diagrams, graphs, etc., and the author’s curriculum vitae
- There is not a preferred font style; however, you can only use one style type (i.e., Times New Roman, Arial, Calibri, etc.).
- The font size must be either 11 point or 12 point size. Similarly, one size must be used for your body text. However, you may have a smaller font size (no smaller than 8 point size) for the title and descriptions of tables, figures, and other inserted items in your document. The font used on your title page and copyright page should be the same size and font used in the main body of your document it should not be bolded.

**Modifying the Normal Style:**

Located at the lower, right-hand corner of the Style section (in the Home’s tab) is a little diagonal arrow. To display the Styles menu, you must click on this arrow. You can also hit Alt+Ctrl+Shift+S.
1. In the Styles box, find Normal. Click the arrow (paragraph scroll) located to the right of the word (Do not click the word ‘Normal’).

2. This will bring up a drop down menu. Select Modify. This will bring up menu called Modify Style.

3. This menu has all of the same features usually found on your toolbar. However, it is where you can change the default settings for your font size and font type, spacing, and more. If you need additional options, you can chose the format button located at the bottom left of the menu box. Remember:
   a. The document must be double-spaced
   b. There is not a required standard font size or style; however, they must be consistent throughout the document.
Section 12: Main body of the Text: Manual for Format Requirements for Margins and Page Numbers

12a: Format Requirements for Margins and Page Numbers

Margins:
- All pages should have a 1” margin on all sides (top, bottom, right, and left).
- Top, right, and left margins must be blank.
- The bottom margin should be blank with the exception of the page number at the bottom center of the page (see below).
- Do not include running headers or footers in your document.

Page Numbers:
- All numbered pages must be numbered in the bottom center of the page.
- When numbering your document, remember that there are three major sections:
  a) Pages without numbers. There are two pages in this section:
     i. The cover page
     ii. The copyright statement (optional)
  b) Pages with lower-case Roman numerals. These represent the front material of your document, preceding the body text and include all materials before the first chapter or section of your thesis or dissertation. Pages that should have Roman numerals include:
     i. Approval page (ii)
     ii. Abstract (starts on page iii)
     iii. Acknowledgements (optional)
     iv. Dedication (optional)
     v. Preface (optional)
     vi. Table of Contents
     vii. List of Tables (if applicable)
     viii. List of Figures (if applicable)
     ix. Any other lists, including: List of Definitions, List of Algorithms, List of Equations (if applicable)
  c) Pages with Arabic numbers. This section is the rest of your document and includes:
     i. Main body of your text (Arabic numeral 1 begins the first page of Chapter 1/Section 1)
     ii. Appendix or appendices (optional)

---

iii. Bibliography (or appropriate name as prescribed by your chosen style guide)
iv. Curriculum Vitae
   o The page numbers within each section are continuous (except the cover page and copyright page).

12b: Setting the Margins in the Word Document

We advise to set your margins prior to writing your thesis or dissertation. In order to change or set the correct page margins:

1. Go to the Page Layout tab. In the Page Setup group, select Margins.

![Margins Tab](Image)

2. Click on Normal. This is not only the most common margin width, but it also fulfills the required format for the margins (1” margins on all four sides of the document).

![Normal Margin Type](Image)

3. When you click on the Normal margin type, your entire document automatically changes to the margin type you have selected.

![Change to Normal Margin Type](Image)
**Note:** Because your document will ultimately have three different sections (due to the three different section breaks), you will need to make sure that the margins are applied to the whole document and not just one of the sections. To set this up, go back to the Page Layout Tab and to Margins. Go to Custom Margins. The Page Setup menu appears. At the bottom of this menu, go to “Apply To.” From the drop-down menu, select “Whole Document.” This ensures that the margins for your entire document are formatted according to the requirements.
Section 12c: Setting the three different page number sections in your Word document

A Few Key Points:
Before beginning the instructions on how to set the three different page number sections in your Word document, there are three points we would like to share that make this process easier.

1. It is easiest to set the three different page number sections **prior to writing** your thesis or dissertation document.

2. Understand page breaks.
   - Word typically inserts a page break automatically once you have reached the end of a page. However, you can insert a page break manually. This should be done when you have completed a chapter and are ready to start on the new chapter. Often individuals hit the Enter key until a new page appears (if they are not at the very bottom of the page). This is not advised because this extra space can cause some of your content to shift unintentionally.
   - In order to insert a page break, find the Page Layout Tab and click Breaks. Another menu appears. Under Page Break, click Page. You can follow these steps whenever you want to start a new page (or chapter/section in your document).
3. Understand section breaks.
   - Section break are primarily used when you want to change the page numbering style of your document or page orientation (portrait versus landscape).

**Note:** Understanding the difference between section and page breaks ensures that you do not use one when you actually meant to use the other. Confusing the breaks can result in formatting issues.

**Setting the three different page number sections using section breaks:**

**Step 1: Breaking your document into three parts**

1. Place your cursor on the first blank page of your new Word template. Go to the Page Layout tab and select Breaks. A menu will appear. In order to insert a section break, you must click Next Page. This breaks your document into two parts.

2. Go to the page that just appeared and repeat Step 1 so that your document is now split into three sections.
3. To determine that the section breaks were put in place correctly, double click on the top of your first page. The headers and footers are displayed, along with the section number.

**Note:** If you have already have written a large portion of your body text without having placeholders for the two different page number sections that are found in your front material, you can still insert section breaks. You will need to insert a blank page before the start of your body text. You can insert a blank page by going to the Insert tab and clicking Blank Page. Make sure that your cursor is placed at the top of the first page of your body text (preceding the chapter/section heading) so that the blank page precedes the body text. You will need to repeat this step again in order to separate your document into three pages. Once this is done, you can add in your section breaks following the directions above. You might need to double check and make sure that no additional paragraph marks have been added to your document. In order to check this, go to the show/hide icon on your Home tab under the paragraph section. If there are extra paragraph markers in your document, make sure you delete them.

You can also use the show/hide icon to check your section breaks as well. You should see a double-line beneath with the words “Section Break.”
Step 2: Setting the different page number sections

A. Setting the first page number section with no page numbers

1. Go to the second section break, specifically the first page of the second section break.
2. Go to the Insert tab and the Header and Footer section. Select Page Numbers. A menu will appear.
3. Select Bottom of Page. Another menu will appear. Choose Plain Number 2 (shows the page number is centered at the bottom of the page as per the format requirements).

5. There are several steps that you need to do here:
   i. Make sure that the option “Different First Page” is selected. If it is not checked, click the box.
   ii. If the “Link to Previous” is highlighted (under Navigation), this means that it is active. Click on it and it will make sure that the first page in the second section break is not linked with the last page in the first section break.
6. Before getting rid of the Header and Footer display, check to see if your first section break has a page number. If it does, highlight the page number and hit delete on your keyboard.

These steps have enabled you to format the page number for the first section break. **Remember:** This section break cannot have page numbers.

B. Setting the second page number section with lower case Roman numerals:

1. Go back to the page number on the first page of your second section break.
2. In order to set lower case Roman numerals, double click on the page number.
3. This will re-display the Header and Footer Tools.
4. Go to the Header and Footer section (left-hand corner).
5. Click on page number and then format page number. The Page Number Format menu will appear.
6. Under number format, select the lower case Roman numeral option from the drop-down menu.

7. In the same Page Number Format Menu, go to Page Numbering.
8. Click Start at.
9. You can either choose lower case Roman numeral ii or iii. The former is chosen if you want to have a place holder for the approval page (This is not required—see Approval Page PDF for more information on the Approval Page). If you do not want to have a place holder, than you must chose the latter (iii), which is the Abstract. The Abstract page technically represents the first numbered page in your document (not including the Approval page).

10. All pages in this section should now have lower case Roman numerals, continuous from either ii or iii.
C. Setting the third page number section with Arabic numbers.
   1. Go to the first page number on the first page of your third section break.
   2. In order to set Arabic numbers, double click on the page number.
   3. This will re-display the Header and Footer Tools.
   4. First make sure, that the “Link to Previous” under Navigation is not highlighted.
   5. Go to the Header and Footer section (left-hand corner).
   6. Click on page number and then format page number. The Page Number Format menu will appear.

   ![Page Number Format Dialog Box]

   7. Under number format, make sure Arabic numbers are selected from the drop-down menu.
   8. In the same Page Number Format menu, go to Page numbering.
   9. Select Start at. Make sure it is 1.
10. All pages in this section should have Arabic numbers, continuous from 1.

**Note:** If you are having issues with your number per each section break not being continuously numbered after the first page, look for the presence of additional section breaks in the rest of your document. Multiple section breaks (outside of the three) can cause inconsistencies in the pagination of your thesis or dissertation document.
Section 13: Format Requirements for an Appendix (or Appendices)

- This section is optional.
- The appendix (appendices) appears after the document text, but before the References.
- All appendices must be listed in your Table of Contents and have the same title format in the text and in the Table of Contents as your other chapter/section headings. (see Section 12: Main Body of the Text: Headings and Subheadings Manual for more information on major headings)
- If you only have one appendix, it will be titled “Appendix” in the Table of Contents and the text. If you have two or more appendices, each should be titled an identifier and label.
  - For example, Appendix A: IRB Permissions and Appendix B: SPSS Data
- All format rules for the body of your document apply to your Appendix. For example: Margins must be 1” on all sides, text must be double-spaced, there can be no running headers or footers, page numbers must be located bottom center on the page, etc.
- The page numbering from the appendix should be in sequence with the last page of the thesis or dissertation document text. Page numbers should be Arabic and continue on through the Bibliography and Curriculum Vitae.
- If a List of Tables, List of Figures, List of Algorithms, etc. appear in the document, items that appear in the Appendix must appear on that list as well (if applicable). For example, if there is a List of Tables and Table 11: Number of Cats Owned appears in Appendix B, it must be listed in the Table of Contents. This means that the table number and caption along with the corresponding page number need to be listed. You do not need to note that it appears in the Appendix.
- Oversized and digital items can be attached to the document through an appendix. The location of each of these items should be referenced in the appendix.
  - For example, Appendix Q: Plate of Sheep Mountain Range. The text under the title would read “Plate is located in attachment three of supplemental material in ProQuest” Or “Plate can be found at www.unlv.edu/geoplates”
Section 14: Format Requirements for the Bibliography/References Section

- The name of this section must be labeled as per the style guide requirements (e.g., Bibliography, References, Works Cited, etc.).

- This section must appear on the Table of Contents.

- The heading of this section (e.g., References, Bibliography, etc.) must match the style of the other major headings used in the document (For more information on major headings, see Section 12: Main Body of the Text: Headings and Subheadings Manual).

- This section does not need to be double-spaced.

- It must follow the same font style and size as the rest of the document.

- It must follow the page numbering sequence from the body text. It is not a separate part of the document. **(Remember: If the document has an appendix, the Reference section appears after the appendix and before your curriculum vitae).**

- References should be consistently formatted and follow the rules of your advisory committee approved style guide.
Section 15: Format Requirements for the Curriculum Vitae

- The name of this section must be labeled: Curriculum Vitae. No other heading will be accepted.

- The section must appear in the Table of Contents. It should be the final item in your Table of Contents and your document.

- It represents the final page(s) of your thesis or dissertation document.

- It must be numbered. The page numbering for the Curriculum Vitae should be in sequence with the previous page of the thesis or dissertation document. Remember: After the front material, all other page numbers are continuous and should be Arabic numbers.

- The Curriculum Vitae should be of professional quality. It does not need to be long but it does need to be clear and provide some form of contact information so peers and other researchers can contact you regarding your work. We recommend using a GoogleVoice number and/or email address that you can be contacted at in the future. You are not required to provide your home and/or mailing address, or your home and/or cell phone number.

- The format should be according to the norms of your discipline as per your committee chair’s advice. Information on creating a CV can be found at: https://owl.english.purdue.edu/owl/resource/641/1/

- See the following page for a Curriculum Vitae sample
Curriculum Vitae

James Hook, Ph.D.

12 Second Street from the Right Lane
Department of English
Jolly Roger University
Never-Never, OR, 12345
Office Phone: (555)-555-5555
E-mail address: JHook@JRU.edu

Education

University of California, Anaheim
Ph.D., English, December 1960
M.A., English, June 1953

University of Edinburgh
M.A., Literature, April 1982